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CHAPTER 5	(	Stretching out


When you’re done building a model, you probably want to do more than look at it against the blank background of the scene. At the very least, you probably want to give your model a title and display it against a colorful background.


This chapter shows what you can do with finished models. It introduces some of the most powerful features of TriSpectives, including collage effects.
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In this chapter


(	The 3D page


(	Creating a collage


(	Embedding the collage in a model


(	Animating a model


(	Moving out of TriSpectives
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(	The 3D page


� XE "Page:Introduction" �Up to now, you’ve done all your work in one area of TriSpectives: the scene. The scene is where you build and edit models.


Use the 3D page to create the final image.�
TriSpectives has another work area: the 3D page. The page is where you combine models and other elements to create your final�
�
image.


For instance, to make a perfume advertisement, you could place a model of the bottle against a silk-textured background and put the name of the product at the top of the page. When you print the page on a high resolution printer, you get a texture that looks like genuine silk and a bottle that could be real.


This section introduces the 3D page. It provides some background information that’s useful before you begin working with the examples in the following sections.


The page and the scene


When you move from the scene to the page, you change your frame of reference. In the scene, the reference point is the model itself, which floats in space. If you want to examine it from different angles, you orbit the model like an astronaut space-walking around a satellite.


On the 3D page, your viewpoint is fixed.�
The situation is the opposite when you work on the 3D page. Your viewpoint doesn’t change. You look down on the 3D page as you�
�
would look at a piece of paper on a tabletop.


When you place a model on the 3D page, it rests on top of the page, just like it would on a piece of paper. If you want to look at it from behind, you need to turn the model over, since your viewpoint remains fixed.


�
Models on the page� XE "Models:On the page" �


You can drop a shape or model on the 3D page, just as you would into the scene. As you add objects, each occupies its own area of 3D space. You can position one independently of the others. If you add lighting effects, the objects cast shadows on each other and on the page.


For example, you might drop models of an airplane and a boat onto the page. If you move the airplane on top of the boat, your view of the boat is obstructed. If you put a light source above the airplane, it casts shadows on the boat and the underlying page.


In other words, working with models on the 3D page is just like positioning real objects on a tabletop.


Scenes on the page� XE "Scene:On the page" �


In most cases, the scene and the page are separate work areas. They behave differently, and you use them at different stages of a project.� XE "Layered scenes" �


Place scenes on a page to create layered images.�
However, there’s one case where they come together. You can place a flat representation of a scene on the page. The effect is like laying down a transparency(a clear sheet that bears the image of a�
�
model. You can add scenes in layers to create a composite image.


For example, suppose that you want to create the image of a teapot sitting on a stove. You have several choices:


You can drag models of a teapot and stove onto the page and move them into the correct position. 


You can place a scene of the teapot on top of a scene with the stove.


You can place a model of the teapot on top of a scene with the stove.


�
Each technique has its advantages. The one you choose depends on the situation. If you’re working with lighting effects, models are useful because they can cast shadows. Layered scenes, on the other hand, are very easy to position. You’ll see examples of both in this chapter.
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(	Creating a collage� XE "Creating a collage" �� XE "Collage" �


As you work through the examples in this section, your goal is a collage:


�


Collage


Naturally, you recognize two elements in this collage: the key and the logo you created in the last chapter. The rest of the collage(the numbers and the wall and so forth(come with TriSpectives in a WorkBook file. To start the collage, open this WorkBook.


(	To open the WorkBook with the collage:


1	From the File menu, choose Open.


2	When TriSpectives prompts you for a WorkBook file, select Collage and choose Open.


The display you see is a 3D page that contains the above collage minus the key and the logo.


�


Page with partial collage


The instructions that follow tell how to add them.


Adding the key to the collage


� XE "Models:On the page" �The process of adding a model to a page is just like adding one to a scene. 


(	To add the model key to the collage:


Select the tab for the Collage Elements catalog.


This is the catalog that you created for the exercises in the last chapter. If you worked through these exercises, the catalog should contain models of the key and the logo. You can also find a key in the Collage catalog that comes with TriSpectives.


Drag the key from the catalog and drop it on the collage.


Drop the key on the right side of the collage near the stairs. You should see a display like the one in the next illustration.


�


Collage after dropping key


After you drop a model on the page you usually need to spend a little time adjusting its position and orientation. For instance, you can make the key in the previous illustration look better by raising and turning it a bit. The next sections tell how. 


Working with the Move In-Out tool� XE "Move In-Out tool" �� XE "Tools:Move In-Out" �


When you create a collage on the 3D page, much of the work involves moving the various elements into place. Take a minute to experiment with the key and see how you can change its position and orientation.


Use the Move In-Out tool to raise or lower a model.�
Use the Move In-Out tool to change the distance between a model and the page. You can raise, or pull, a model up from the page towards your point of view. You can also lower, or push, a model�
�
towards the surface of the page.


As you pull a model towards you, it appears to get bigger. As you push it away from you, it seems to get smaller. The size of the model doesn’t change, though, just its distance from the page.


To become familiar with the Move In-Out tool, try using it with the key model.


(	To move the key and change its apparent size:


1	Select the key model.


For information on selecting models and other objects, refer to “Editing models, shapes, and surfaces” in Chapter 3. 


��
2	Choose the Move In-Out tool.�
�
Move the pointer anywhere on the 3D page.


4	Drag upward to make the model appear bigger or downward to make it look smaller.


The Move In-Out tool works with one model at a time. If the page contains other models, they remain at their current elevation. You can raise or lower one model to place it in front of or in back of another one. 


It’s also possible to drag a model through another object or the page itself. This technique can be useful if you want two objects to intersect. For instance, you might use the Move In-Out tool to lower a model boat so it appears partially submerged under water.


If you drag an object too far so that it disappears under the page, you can still drag it back as long as it’s selected. If you need to re-select it, use the WorkBook Browser. For information on the Browser, see “Selecting the parts of a model” in Chapter 1 of the TriSpectives Reference Guide. This section describes the Browser along with other selection techniques.


Rotating a model on the page


Since your viewpoint on the page is fixed, the camera tools aren’t available. If you want to see a mod� XE "Rotating an object:On the page" �el from a different angle, you rotate the model. Use the TriBall tool for this purpose. It works on the 3D page just like it does in the scene. Try using it to rotate the key so it appears at a slight angle. For details on the TriBall, see “Introducing the TriBall tool” in the last chapter.


Dragging a model on the page


The last tool for positioning models on the 3D page is a familiar one: the standard drag-and-drop technique.


(	To move a model on the page:


1	Select the model.


2	Drag the model to its new location.


�
Adding the logo


You’ve seen how to add 3D models to a collage. By moving a model in 3D space, you can place it in front of or behind other models. 


You can create a collage from models,  scenes, or both.�
There’s another way to build a collage. TriSpectives lets you embed scenes within the page. An embedded scene is like a flat photograph of a 3D scene or model.�
�
You can create a new embedded scene using the Scene command on the Insert menu. That isn’t necessary with the logo, however. When you saved it in the catalog at the end of the exercise in � XE "Scene:Embedded" �Chapter 4, you saved the logo and the scene that contains it. 


(	To add the logo to the collage as an embedded scene, drag it from the Collage Elements catalog and drop it on the page.


� XE "Embedded scene" �The page with the embedded scene should look like this:


��


Page with embedded scene


If your logo appears on a gray background, you can easily change it so that it doesn’t obstruct other parts of the collage.


(	To remove a gray background from your logo:


Right-click the embedded logo scene to see its pop-up menu.


Choose Embedded Scene properties from the pop-up menu.


Select the Drawing Style tab.


Choose the Make Background Transparent option.


Choose OK.


Use the camera tools to change the image in the embedded scene.�
Notice that some of the camera tools are active. You can use them to manipulate the image in the embedded scene. For example, to change your viewpoint so the logo appears at an angle, use the�
�
Orbit Camera tool.


You can also change the size of the image by dragging one of the handles of the bounding box. Work with the scene until the logo � XE "Scenes:Layered" �has the right size, position, and orientation for � XE "Layered scenes" �the sample collage.


Working with layered scenes


In addition to the logo, the collage has a couple of other embedded scenes. Just underneath the logo is an embedded scene that contains the cross-hatched wall.


One advantage of layered scenes is that it’s very easy to rearrange the layers. For example:


(	To move the logo behind the wall, click the logo scene to select it and choose Send to Back from the Shape menu.


The logo disappears behind the wall. To see it again, choose Bring to Front from the Shape menu. This option(along with Bring Forward and Send Backward, which move a scene one layer in a stack of scenes(gives you a quick way to position the elements of a collage. 


Editing an embedded model� XE "Editing an embedded model" �


One of the best features of TriSpectives is that you can work with a model that’s part of a larger illustration. When you double-click on an embedded model(like the cellular telephone in the collage(all the model-building tools become available.


In this section, you see how to work with a model in an embedded scene. You edit the telephone model in a 3D scene, change its color, and return the phone its place in the collage.


(	To edit the telephone model in a 3D scene, double-click it.


The embedded scene with the telephone appears in a new document. 


�


Cellular phone ready for editing


At this point, you’re working in a 3D scene like the ones you saw in previous chapters. All the model-building features are available including the Camera tools and the 3D Shape tools.


(	To change the color of the phone:


Click the phone to select the entire object.


Click the body of the phone to select it.


Drag a color from the Colors catalog and drop it on the body of the phone.


TriSpectives displays the Style dialog box. This dialog box gives you the opportunity to replace a style for all models in a group such as the telephone.


Choose Replace styles for all models in the group.


Choose OK.


TriSpectives prompts you for permission to replace the surface styles in the group.


Choose No.


Now that you have a designer telephone, you can go back to the collage on the 3D page. 


�
(	To return to the 3D page, choose Close from the File menu.


TriSpectives closes the document with the embedded scene. When the collage on the 3D page reappears, notice the new color of the telephone.


� XE "Page:Saving" �Saving the page


At this point, all the pieces of the collage are in place. The next section uses the collage as part of a larger project.


In order to retrieve the collage later on, you need to save the page that contains it. This technique is very much like the one you saw in the last chapter for saving a 3D scene in a catalog.


(	To save the page with the collage:


Click and drag the page tab into the Collage Elements catalog.


After you drop the page, rename its icon “Collage page.”


You may want to save the catalog before proceeding. From the Catalogs menu, choose Save.
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(	Embedding the collage in a model


� XE "Page:Embedded" �� XE "Embedded pages" �You’ve seen how TriSpectives lets you embed a 3D scene within a page. You used this technique to add the logo to the collage.


You can embed a page in a 3D scene to place  an image on a model. �
TriSpectives lets you go the other way, too. You can embed a collage or any other illustration on a 3D page within a scene. This powerful tool lets you add complex graphics to the surface of a�
�
model.


For example, you can add the collage to one of the models that comes with TriSpectives. The Box model represents the TriSpectives package. It’s missing its front, however.


(	To add the collage to the Box model:


Add a blank 3D scene to your WorkBook.


Drag the Night graphic from the Backdrop catalog and drop it in the scene.


This photograph of a night sky makes an impressive background for the TriSpectives box.


Drag the Box model from the Collage catalog and drop it in the 3D scene.


�


Box model


��
4	Use the Look At tool to view the box front straight on.�
�
Select the Look At tool and then click the blank surface on the front of the box. You should see a blank rectangle.


Drag the Collage page item from the catalog and drop it on the front of the box.


TriSpectives displays the collage as an embedded page within the scene.


�


Embedded page on top of box


Resize the embedded page so its dimensions are the same as the box.


Drag the handles on the page until its edges are flush with the box. It may help to use the Orbit Camera tool to view the box from a slight angle. Here is the box with the resized page:


�


Box with resized page


If you look closely, you’ll notice that the page floats slightly off the surface of the box. You can adjust the height of an embedded page using its property sheet.


(	To adjust the height of the page from the box:


Right-click the collage to see the pop-up menu for the page.


Choose Embedded Page Properties from the pop-up menu.


Select the Sizebox tab.


Change the value in the Height field to 2.5.


Choose OK.


TriSpectives moves the embedded page close enough to the model so it appears to be part of the box.


Once you’ve adjusted the height of the page, try using the Orbit Camera tool to examine the box from different angles. Notice that the collage rotates with the box model as if they were one unit. 


(


(


(


(	Animating a model� XE "Animation" �


While you have the box on your screen, try bringing it to life with the TriSpectives animation features. 


(	To animate a model so that it flies into the picture:


Display the Timeline toolbar� XE "Timeline toolbar" � if it isn’t already available.� XE "Toolbars:Timeline" �


Select Toolbars from the View menu. When the Toolbars dialog box appears, check Timeline and choose OK.


Select the tab for the Animation catalog.


Drag the Fly In item from the catalog and drop it on the 3D scene.


��
4	� XE "On tool" �To turn on the TriSpectives animation features, click the On button on the Timeline toolbar.� XE "Tools:On" ��
�
��
5	Select the Play tool.� XE "Play tool" �� XE "Tools:Play" ��
�
TriSpectives animates the model. The TriSpectives product box flies into the scene.


TriSpectives comes with a variety of animation effects called SmartMotions. Try adding other SmartMotions� XE "SmartMotions" � to the scene that contains the box. For instance, try adding the Width Spin item. When you play the resulting animation, the box spins as it flies into the scene.


In addition to the items in the Animation catalog, you can define your own. For more information, refer to the “Animation” chapter in the TriSpectives User Guide.
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(	Moving out of TriSpectives


The world of 3D documents is much larger than TriSpectives itself. You can use the graphics you create in TriSpectives with word processors, Email packages, and other software.


TriSpectives is especially useful when you combine it with other programs that support OLE (Object Linking and Embedding) 2.0. For example, you can embed 3D graphics in a document that you create with Microsoft Word or another word processor that supports OLE 2.0. You might drag your cellular phone model out of TriSpectives and drop it into a Word document.
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